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WINDOWS

1. Pé thay déi ngay gio hé thong may tinh dang sir
dung ta c6 thé dung :
a. Chuong trinh Date/Time trong cira s6 My
Computer
b. Chuong trinh Date/Time trong cira 6 Control
Panel
¢. Chuong trinh Date/Time trong cira $6
Windows Explorer
d. Start > Programs > Date/time
2. Trong Windows Explorer dé tim tap tin hay thw
muc ta vao :
a. File, Clear
b. Folder, Find
c. File, chon File or Folder
d. Ba cau trén déu sai
3. Trong Windows Explorer muon ddi tén mat thw
muc ta dung Iénh hay phim néng nao sau day:
a. Click vao tén thu muc va dung Iénh Edit >
Rename
b. Click vao tén thu myc va nhan phim F2
c. Caavabdéusai
d. Caavab déuding
4. Trong khi l1am viéc véi Windows néu ta nhan
Ctrl + ESC thi:
a. Kich hoat Start Menu
b. Pong ctra s6 dang lam viéc
c. Thoéat khoi méi truong Windows
d. Chuyén lam viéc sang cira s6 ké tiép
5. Dé siap xép vi tri cac biéu twong trén Desktop ta
chon :
a. Properties
b. Active Desktop
c. Arrange Icons
d. Refresh
6. Mudn x6a 1 chwong trinh trong Windows, ta
dung chwong trinh nao hay thao tac nao sau day:
a. Add/ Remove Hardware
b. Add/ Remove Programs
c. X0a biéu twong trén man hinh Desktop
d. Cac ciu trén déu sai
7. Pé mé mot cira s6 folder hosc mgt mue chwong
trinh, ta phai thao tac nhw sau:
a. Nhay chudt vao biéu twong, nhan Enter
b. Bam chudt nhanh hai lan tai biéu tuong twong
ung
c. Chi chudt vao biéu tuong, click nt phai, chon
Iénh Open
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d. Mot trong cac cach trén
8. Pé cai dit thém cac bo Font trong méi truwong
Windows, ta dung chirc ning:
a. Fonts cua Control Panel
b. System caa Control Panel
c. Desktop cua Control Panel
d. Regional Settings cua Control Panel
9. Lénh Move trong hép Menu diéu khién ding:
a. Thay dbi vi tri thé hién menu bar trong cua )
b. Thay doi trang thai dong, mo cua cua s6
c. Thay ddi kich thuéc cira s6
d. Thay dbi vi tri cia cira s6 lam viéc
10. Trong Windows Explorer, dé danh d4u chon
tat ca cac doi twong trong cira s6 Folder hién tai,
ta nhan phim:
a. F7
b. F8
c. Ctirl+A
d. Tatca déu sai
11. Chi chut vao khoang tréng trén Taskbar,
click nat phai chugt, chon Cascade Windows la:
a. Sap xép cac cira s6 dang mo theo dang canh
nhau
b. Sap xep cac biéu tugng trong cta s6 dang mo
c. Sip xép cac ctra s dang mé theo dang lop
ngoi
d. Sip xép cac biéu twong hién co trén Desktop
12. Pé tao thu muc con méi trong Windows
Explorer, ta chon Iénh:
a. File, New, Folder
b. File, New, Directory
c. File, Properties, Folder
d. File, Create Directory
13. Pé sao chép mdt Shortcut trén Desktop:
a. Click nat phai chuét tai Shortcut va chon
Copy
b. Click nat phai chu6t tai Shortcut va chon
Delete
c. Click nat phai chuét tai Shortcut va chon
Rename
d. Click nat phai chuét tai Shortcut va chon
Paste
14. Pé c6 thé quan sat thoi gian trong lic lam viéc,
ta c6 thé mé hop thoai Taskbar Properties va
chon:
a. Auto hide
b. Show clock



c. Always on top
d. Small icon in start menu
15. Trong hép thoai Taskbar Properties, dé dong
Taskbar lubn xuat hién trén man hinh, ta chen:
a. Small icon in start menu
b. Always on top
c. Show clock
d. Auto hide
16. Trong Windows Explorer, muén thé hién céc
déi twong c6 thudc tinh an trong cira s6 thu muc,
ta dung menu:
a. View, Folder
b. View, Show/Hidden
c. Tools, Show/Hidden
d. Tools, Folder Options
17. Muén chay mét chwong trinh trong Windows
ta co thé:
a. Vao ctra s6 My Computer va double click tén
chuong trinh
b. Vao Windows Explorer, click vao tén chuong
trinh va Enter
¢. Click Start, click Run, gd dudng dan dén tén
chuong trinh d6 va Enter
d. Céc cach trén déu dung
18. Trong Windows Explorer, dé di chuyén mét
tap tin da chon, ta thuc hién:
a. File, Remove
b. File, Move
c. Edit, Cut
d. Ba cau trén déu sai
19. Trong Windows Explorer, dé cai dit thudc tinh
mot tap tin da chon, ta vao:
a. File, Properties...
b. File, Archive
c. File, Attribute
d. Ba céu trén déu sai
20. Trong Windows Explorer, mudn x6a thuw muc
ta vao:
a. File, Move
b. File, Delete
c. File, Delete Directory
d. Khong cach nao ding
21. Trong Windows Explorer, dé doi tén mét thu
muc da chon, ta vao:
a. Edit, Rename
b. File, Rename
c. File, Remove
d. Khong cau nao ding
22. Trong Windows Explorer, mudn x6a mot tap
tin da chon, ta nhay chugt phai vao tén tap tin, sau
do chon:

a. Delete

b. Delete File

c. Move

d. Khong cau nao ding

23. Trong Windows, xem té chirc cac tép, thu muc
trén dia, ta dung:

a. My Computer

b. Windows Explorer

c. Word, Excel

d. My Computer hay Windows Explorer
24. Pé khéi dong Windows Explorer trong moi
treong Windows, ta c6 thé sir dung:

a. Start, Run, g6 Explorer

b. Right Mouse tai nut Start, chon Explorer

c. Céauavab déu dang

d. Cauavab déu sai
25. Trong Windows, dé chon cac thuw muc lién tuc
ta chon:

a.  Nhan gitr phim Shift ri click chon lan luot

b. Nhan gii phim Ctrl rdi Click chon lan luot

c. Cauavab déu sai

d. Cauavab déu dung
26. Trong Windows, tim file/folder ta thuc hién:

a. Mo My Computer, nhay File, Open

b. Mo My Computer, nhay Edit, Find

c. Start, Run, g vao tén file/folder can tim

d. Start, Search, g vao tén file/folder can tim
27. Regional and Language Options ciaa Control
Panel quy wéc Kiéu ngay thang 1a dd/mm/yy, thi
khi nhap 20/11/2010, ta dwoc:

a. 11/20/10

b. 10/11/20

c. 10/20/11

d. 20/11/10
28. Trong Control Panel, vao Regional and
language Options > Customize > Time véi muc
dich:

a. Thay ddi gio hé thong

b. Thay d6i cach hién thi ngay

c. Thay ddi kiéu hién thi gio

d. Khong cau nao dung
29. Trong My Computer, phat biéu nao sai vé cac
nat 1énh trén thanh cdng cu:
NUt lénh Back dé vé cura so truéc
Nt Search dé tim kiém file va folder
Nut Up dé mé thu muc dang chon
Nt 1énh Folder dé m¢ cira s cay thu muc
trén dia
30. Khi x06a tap tin / thu muc, néu ta nhan té hop
phim Shift + Delete, thi tap tin/thw muc bi x0a Sé:

a. Puoc dua vao trong Recycle Bin va c6 thé co

phuc hoi lai dugc
b. Mét di hoan toan va khdng thé phuc hoi lai
duoc

c. Cauavab déu sai

d. Céuavab déu dang
31. Khi x6a mét folder ma bén trong c6 cac folder
con va céc file thi:

a. Cac folder con va céc file khéng bi xda theo
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b. Cac folder con va cac file bi x6a theo
c. Chi cé cac folder con bi x0a, cac file khdong bi
x0a
d. Chi cé cac file bi x0a, cac folder con khong bi
x0a
32. Trong Windows Explorer, muén chon (danh
d4u) mdt nhom céc tap tin nam rai rac cach nhau,
fa:
a.  Nhan phim Alt roi Click cac tap tin mudn
chon
b. Nhan phim Shift roi Click cac tap tin mudn
chon
c.  Nhan phim Ctrl rdi Click céc tap tin muén
chon
d. Ba cau trén déu sai
33. Pé mé Windows Explorer ta thuc hién:
a. Start, Run, gd Explorer
b. Nhan té hop phim [ + E
c. Click phai vao My Computer, chon Explorer
d. Cac cau trén déu ding
34. Trong Windows, dé tao thw muc ta thuc hién:
a. Chon File, New, Folder
b. Click phai chudt, chon New, Folder
c. Cauavab déu sai
d. Céuavab déu ding
35. Pé ddi tén Folder trong Windows Explorer ta
str dung:
a. Nhay chuét 2 1an cham vao folder
b. Nhay chudt phai vao folder, chon Rename
c. Chon folder va nhan phim F2
d. Cac cau trén dung
36. Trong Windows Explorer, dé xem dung lugng
dia sau khi chon dia cin xem, ta chon:

WORD

1. P& dan viin ban dén mét vi tri nao do, ta chon:
a) Ctrl+P. ¢) Caavab déu ding.
b) File/ Paste. d) Caavab déu sai.
2. Pé dinh dang trang, ta thyc hién:
a) File/ Page Setup. c) Edit/ Page Setup.
b) File/ Prmt Setup.
3. Dé danh sb thi tu cac doan van ban, ta chon:
a) View/ Bullets and Numbering...
b) Edit/ Bullets and Numbering....
c) Format/ Bullets and Numbering....
d) Insert/ Bullets and Numbering....
4. Mu6n chén anh cé sin trong Word vio vin
ban,ta:.
a) Nhin Ctrl + P.
b) Chon Iénh Insert/ Picture/ Clip Art.
c) Chon lénh Insert/ Picture/ From File.
d) Nhén nut Insert.
5. Pé tao chir cai 16n diu doan vin trong Word,
ta:

d) Format/ Page Setup.

a. File, Properties
b. View, Properties
c. File, Format
d. Cac cau trén sai
37. Pé chuyén doi giira cac cira s6 lam viéc trong
Windows, ta thuc hign:
a. Nhay chudt vao biéu tugng chuong trinh
tuwong tng trén thanh céng viéc
b. Nhan giir phim Alt va nhan phim Tab nhiéu
1an cho téi khi chuong trinh twong tng dugc
dong khung
c. Cauavab deu sai
d. Céauavab déu dang
38. Trong Windows Explorer, dé sao chép mat tap
tin da chon, ta thuc hién cach nao sau day:
a. Nhan t hop phim Ctrl + C
b. Click nat phai chudt vao tap tin roi chon Copy
c.  Nhan giir phim Ctrl roi thuc hién kéo tha
chudt sang vi tri méi
d. Ca 3 cach trén déu dang
39. Trén Desktop ciia Windows, dé tao biéu twgng
chwong trinh, ta nhay chudt phai roi chon:
a. New, Folder
b. Properties
c. New, Shortcut
d. Khong c6 cau nao ding
40. Trong Windows Explorer, dé x6a tap tin hay
thw muc, ta thuc hién:
a. File, Delete
b. Nhin t6 hop phim Ctrl + D
c. Click phai chu6t vao tap tin hay thu muc,
chon Delete
d. Céc cach trén déu dung

a) Chon Insert/ Drop Cap.
b) Chon Format/ Drop Cap.
c) Chon Format/ Characters/ Drop Cap.
d) Chon Tools/ Drop Cap.
6. D¢ thay thé tir hay cum tir, ta thye hién:
a) Lénh Edit/ Go to. ¢) Lénh Edit/
Find.
b) Lénh Edit/ Search
Replace.
7. Mudn lvu vin ban vao dia:
a) Chon File/ Save.
b) Nhan t6 hop phim Ctrl + S.

¢) Nhaén nut Save = trén thanh cong cu.
d) Ca3 cau trén déu dung.
8. T6 hop phim Ctrl + Y la:
a) Huy bo thao tac vira thyc hién.
b) Huy bo thao tac vira xoa.
c) Khoi phuc thao tac vira thyc hién.
d) Khoi phuc thao tac vira hiy bo.

d) Lénh Edit/



9. Pé thay déi vi tri 18 ciia cac doan vin ban, ta
phai:

a) Chon Format/ Paragraph va thay d6i cac thiét

dat & muc Indentation.

b) Chon Format/ Tabs.

¢) Chon Format/ Spacing va thay ddi cac thiét

dat & muc Indentation.

d) Chon nit Paragraph Spacing trén thanh cong

cu.
10. Muén hién thi thanh céng cu dinh dang
(Formatting) ta cin thuye hi¢n thao tic nao?
a) Chon Toolbars/ View/ Formatting.
b) Nhip phai chudt tai ving trong vin ban chon
Formatting.
c) Chon View/ Toolbars/ Formatting.
d) Chon Tools/ Customize, chon Toolbars/
Formatting.
11. Trong Word dé tao bang ta chon:

a) Insert/ Table. c¢) Tools/ Insert/ Table.

b) Insert/ column.
12. Trong Word dé tao dwong vién cho mjt
bang ta chon:

a) Format/ Borders and Shading.

b) Table/ Borders.

c) Table/ AutoFormat.

d) Format/ Drawing.

13.  Trong Word dé t6 mau 6 di dwgc danh dau
ta chon:

a) Format/ Borders and Numbering.

b) Format/ Borders and Shading.

c) Table/ Borders.

d) Ca3 cau déu sai.

14.  Trong Word dé lwru mdt viin ban véi tén
khac ta chon:
a) File/ Save. c) File/ Save As.

b) Edit/ Save. d) Ca 3 cau déu dung.
15. Trong Word dé chén mét hinh anh ta chon:
a) Insert/ Symbol. c) Insert/
Object.
b) Insert/ Picture. d) Insert/ Photo.
16. Trong Word dé sip xép cac dir li¢u ciia mot
bang ta chon:
a) Table/ Fornula c) Tools/ Formula
b) Tools/ Sum d) Table/ Sort
17.  Trong Word ta ¢é thé mé dwoc nhiéu tap
tin, dé 1am viéc véi mot tap tin dd mé ta chon:
a) Window/ Tén tap tin. c¢) Tools/ Tén tap tin.
b) File/ Tén tap tin. d) Edit/ Tén tép tin.

18. Trong Word nit Iénh = dung dé:

a) Tao tap tin. c) Mo tap tin.

b) Sao chép tap tin. d) Luu tap tin.
19. Trong Word dé thém mot cot vao mot bang
ta chon:

a) Insert/ Row.

d) Table/ Insert/ Table.

b) Insert/ Column.

c) Edit/ Insert/ Column.

d) C43 cau déu sai.
20. Trong Word mudn chuyén déi chir hoa
sang chir thwong hoic ngworc lai ta ding to hop
phim:

a) Alt+F3. c) Ctrl + Shift + B.

b) Ctrl + F3. d) Ca3 cau déu sai.

21. Trong Word nut Iénh dung dé:
a) Canbh trai cac dong van ban trong mot doan.
b) Canh phai cac dong van ban trong mot doan.
¢) Canh déu cac dong vin ban trong mot doan.
d) Canh déu khoang cach cac dong.

22.  Trong Word nut 1énh |*=. dung dé:
a) Tao nut Bullet dau dong.
b) Panh sb tu dong.
¢) Di chuyén doan vin ban sang phai.
d) Canh déu khoang cich cac dong.

23. Trong Word nut I¢nh & dung dé:
a) Sao chép doan van ban.
b) Dan doan van ban.
¢) Di chuyén doan van ban di noi khac.
d) Luu van ban.
24. Trong Word t6 hop phim Crtl + L ding dé:
a) Canh I phai mot doan van ban.
b) Canh 1¢ trdi mot doan van ban.
c) Canh gitra mét doan van ban.
d) Ca3 cau déu sai.
25. Trong Word dé chon khdi thay cho diing
chudt, ta dung 4 phim mii tén va phim:
a) Alt
b) Citrl.
c) Shift.
d) Khéng st dung ban phim dé chon duoc.
26. Trong Word khi dang lam viéc véi mt van
ban, t6 hop phim Ctrl + F4 dung dé:
a) Thyc hién tiép viéc vira lam.
b) Xoa mot doan van ban.
c) Inmot doan van ban.
d) Ca3 céu déu sai.
27. Trong Word dé danh ky hiéu thir tw ty
dong dau dong, ta chon:
a) Insert/ Bullets and Numbering.
b) Format/ Bullets and Numbering.
c) View/ Bullets and Numbering.
d) Ca3 cau déu sai.
28. Trong Word ta chon Insert/ Picture 1a dé :
a) Chén mot hinh anh.
b) Chén mot doan van.
€) Xoa mdt hinh anh.
d) Ca3 cau déu sai.
29. Trong Word t6 hop phim Crtl + H ding
de:
a) Tim va thay thé mot chudi.



b) Lam 4n mot doan vin ban.
¢) Canh 18 trai mot doan van ban.
d) Ca3 cau déu sai.
30. Trong Word t6 hop phim Crtl + B dung dé:
a) Dinh dang ky tu hoa doan van ban da chon.
b) Dinh dang ky tu nghiéng doan van ban da
chon.
c) Dinh dang ky tu dadm doan van ban da chon.
d) Ca3 cau déu sai.
31. Trong Word dé canh giira mét dong vin
ban, ta dung t6 hop phim:
a) Ctrl+G. c) Ctrl +E.
b) Ctrl+C. d) Ctr+R.
32. Trong Word muén dinh dang chir hoa, ta
chon:
a) Format/ Font chon vao 6 All caps.
b) Format/ Font chon vao 6 Caps Lock.
c) Format/ Font chon vao 6 Small caps.
d) Ctr+F3.
33. Trong Word dung to6 hgp phim Crtl + C,
roi Ctrl +V 1a @é:
a) Di chuyén mdt doan vin ban dén mot vi tri chi

dinh.
b) Sao chép mot doan van ban dén mot vi tri chi
dinh.
c) Catboé mot doan van ban dén mot vi tri chi
dinh.

d) Ca3 cau déu dung.
34. Muén khéi phuc thao tic vira hity bé, ta
thwe hién:

a) Ctrl+X c) Ctrl+Y.

b) Citrl + Z d) Ctrl +W.
35.  Nhian Ctrl + End dong thoi sé thue hién
viéc nao:

a) Dit con tro vin ban dén cudi tir hién tai.

b) Dit con trd vin ban dén cudi doan hién tai.

¢) Dit con tro vin ban dén cudi dong hién tai.

d) Pat con tré vian ban dén cudi vin ban.
36.  Dé sao chép doan vin tir vi tri nay sang vi
tri khac trong mot vin ban bang cach kéo tha
chudt, cin phai nhan giir phim nao trong khi kéo
tha?

a) Nhan giit phim Shift.

b) Nhén giit phim Alt.

¢) Nhan giit phim Ctrl.

d) Nhan giir dong thoi 2 phim Ctrl + Alt.
37. Pé dinh dang chir dam, ta dung to hop

phim nao?
a) Ctrl +E. c) Ctrl+1.
b) Ctrl +B. d) Ctrl+U.
38. Pé xo04 phan viin ban dwoc chon va ghi vao

b0 nhé dém, ta:
a) Nhan Ctrl + X.
b) Chon Edit/ Cut.
¢) Nhin nat Cut trén thanh cong cu.

d) Ca3 cau déu dung.
39. Mudn hién thj thanh céng cu dinh dang
(Formatting) ta cin thye hi¢n thao tac nao?
a) Chon Toolbars/ View/ Formatting.
b) Nhip phai chudt tai ving trong van ban chon
Formatting.
c) Chon View/ Toolbars/ Formatting.
d) Chon Tools/ Customize, chon Toolbars/
Formatting.
40.  Dé thay déi c& chik, ta thwe hién 1énh
Format/ Font... va chon c¢& chir trong 6:
a) Font style. c) Font.
b) Small caps. d) Size.
41 Pé gach dwéi mdt tir hay cum tir, ta nhén:

a) Ctrl+1. c) Ctrl+D
b) Citrl + U. d) Ctrl+E
42.  Pé canh 1¢ déu 2 bén cho doan vin ban, ta
chon:
a) File/ Page Setup. c) Ctrl +J.
b) Format/ Justify. d) Ctrl + E.

43.  Pé dinh dang trang, ta thuc hi¢n:
a) File/ Page Setup. c) Edit/ Page Setup.
b) File/ Print Setup. d) Format/ Page Setup.

44.  Chirc ning cia nut Iénh 0% &
a) Dinh cd chir.
b) BDinh khoang cach giira cac doan van ban.
€) Thu nho van ban.
d) Thay d6i ti 1¢ hién thi vin ban.
45, P& xem vin ban trude khi in, ta:
a) Chon File/ Print Preview.
b) Chon View/ Print Preview.
c) Chon File/ Page Setup.
d) Chon Edit/ Print Preview.
46.  Pé in viin ban, cich nao sau day la sai:
a) Chon File/ Print.
b) Chon File/ Print Preview.
¢) Nhan nit Print trén thanh cong cu.
d) Nhan t6 hop phim Ctrl + P.
47. Pé tao chir cai 16n dau doan vin trong
Word, ta:
a) Chon Insert/ Drop Cap.
b) Chon Format/ Drop Cap.
c) Chon Format/ Characters/ Drop Cap.
d) Chon Tools/ Drop Cap.
48. Pé thay thé tir hay cum tir, ta thyce hién:
a) Lénh Edit/ Go to. ¢) Lénh Edit/ Search.
b) Lénh Edit/ Find. d) Lénh Edit/
Replace.
49.  Dé tao bang, ta thyc hi¢n:
a) Lénh Table/ Insert/ Table.
b) Lénh Insert/ Table.
¢) Nhan Ctrl + T.
d) Nhén nat Table trén thanh cong cu.
50.  Dé sip xép dir liéu trong bang, ta chon:
a) Tools/ Sort.

1a:



b) Edit/ Sort.
c) Toolbars/ Sort.

d) Nhip chudt vao nut |%J' trén thanh cong cu.
51.  Dé thay d6i dang chir hoa, chir thudmg cho
mot khoi viin ban da dwgc danh diu, ta c6 thé sir
dung menu 1énh hoic t6 hop phim nao sau day:

a) Format, Change Case

b) Shift+ F3

c) Chico cau a dung, cau b sai

d) Cahai cdu a va b déu dung
52. Trong WinWord, mudn déng cira so vin
ban dang soan thio, ta c6 thé dung:

a) Alt+F4

b) Ctrl+F4

¢) Caavab déu dung

d) Caavadéusai
53. Trong WinWord, phat biéu nao sai khi néi
dén cac nit 1énh trén thanh cong cu:

a) Nhap nat Copy dé sao chép khéi van ban dugc

chon vao bd nhé tam

b) Nhap nat Cut dé di chuyén khéi vin ban dugc

chon vao bd nhé tam

C) Nhép nut Paste dé léy ndi dung tir bd nhd tam

d) Nhip nat Format Painter d&é dinh dang mau

nén cho khdi van ban duoc chon
54.  Trong WinWord, dé x6a mgt dong trong
Table, ¢6 thé:

a) Chon dong rdi 4n phim Delete

b) Chon dong, chon Table, Delete, Rows

c) Chon dong, chon Rows, chon Delete

d) Nhap phai 1én mot 6 dong, chon Delete
55. Pé danh dau chon toan bd vin ban trén
man hinh, ta c6 thé:

a) Nhan Ctrl-A

b) Click nhanh chudt 3 lan trén ving lua chon

¢) Nhan Ctrl, kich chudt trén ving lua chon

d) Ca3cauA, B, C déu ding
56. Khi con tré ¢ 6 cudi cing trong bang, néu
ta nhin phim Tab thi:

a) Sé cho bang thém mot dong mai

b) Con tro s€ nhay ra doan van bén dudi bang

¢) Con tro dung yén vi di hét bang

d) Con tro nhay vé 6 dau tién ciia bang
S7. Pé chuyén ddi qua lai gitra cac tai liéu dang
soan thao trong winword, ta c6 thé ding:

a) Menu Windows, Switch to

b) Menu Windows, Task List

c) Menu Windows, List

d) Nhén Ctrl — F6
58. Chirc nang Formula trong menu Table
dung dé:

a) Chén mot ky hi¢u vao 6 trong bang

b) Chén mot cong thirc tinh toan vao 6 trong

bang

c) Cheén mot hinh anh vao 6 trong bang

d) Sap xép bang theo trat tu nao d6
59.  Pé dit dwong din hwéng (dwong ké... ) dén
1 diém dirng ta sir dung menu :
a) Format, Tabs, Leader
b) Format, Tabs, Alignment
c) Format, Border and Shading
d) Format, Tabs, Gridlines
60. Dé thay ddi ¢& chir cho 1 nhém Ky tu ta c6 thé
dung
a) Format, Font, Font size
b) T6 hop phim Ctrl — Shift— P
¢) T6 hop phim Ctrl — P
d) Cauahaycaub
61. Ta c6 thé dung thwéc cin ngang trén man hinh
dé diéu chinh:
a) Bién trai doan van ban
b) Bién phai doan van ban
¢) Vitridong 1 vanhtrng dong con lai
d) Cac cau a, b, ¢ déu dung
62. Trong WinWord sau khi dinh dang in nghiéng
cho 1 khoi, mudn x6a dinh dang ciia khéi d6 ding
1énh hay t6 hop phim gi?
a) Ctrl-I
b) Ctrl-SpaceBar
c) Click Regular sau khi dung 1énh Format, Font

d) Cac cau trén déu dung
63. Trong WinWord muén ké dwong thiang cho
that thang thi phai dé phim gi trudc khi kéo chudt
a) Ctrl - Alt
b) Ctrl — Shift
c) Shift
d) Tab
64. D¢ chén mt tap tin trén dia vao vin bin dang
soan thao tai vi tri con tro, ta sir dung:
a) Insert, File
b) Insert, Object
c) Insert, Field
d) Insert, Symbol
65. Hop thoai Paraghaph, thong bao Indentation
left: 3 cm. Piéu nay c6 nghia:
a) Tat ca cac dong trong doan thut vao 3cm
b) Dong dau tién ciia doan thut vao 3 cm
c) Tudong thur 2 tré di thut vao 3 cm
d) Lé gidy dd chirala3cm
66. Cai dat chirc ndng tu dong luu vian ban sau
mot khoang thoi gian trong WinWord, ta dung:
a) Tools, Option, Save
b) Tools, Options, General
¢) Tools, Options, Save As
d) Tools, Save
67. Pé chia ct cho viin bin dang soan, ta cé thé:
a) Nhan Ctrl + Shift + Enter
b) Nhan Ctrl + Enter
c) Dung menu Format, Columns



d) Dung menu Tools, Columns
68. Trong WinWord, dé dinh dang font chir mic
dinh, ta vao:

a) Format, Font, chon font, Default, OK

b) Format, Font, chon font, OK

c) Edit, chon font, Default

d) Bacau trén sai
69. Trong mot vin ban WinWord, dé tich mét
bang tai vi tri da chon, ta vao Table va chon:

a) Split Table

b) Split Cells

c) Merge Cells

d) Ba cach trén déu sai
70. Trong WinWord, dé lwu tip tin dang lam viéc
thanh tap tin khac ta dung cap phim:

a) AltvaF,gd A

b) AltvaF,gdS

c) CtrlvaF,gd A

d) CtrlvaF,g6S
71. Pé tao m6i mot vin ban trong trén Word, ta:

a) Nhan t6 hop phim Ctrl + O

b) Chon Edit - Cut

¢) Nhan t6 hop phim Ctrl + S

d) Nhan t6 hop phim Ctrl + N
72. Trong WinWord, sau khi 1& x6a nham mt
doan viin ban hodic mét thao tic niao dé lam mat di
ndi dung vin ban, ta c6 thé phuc hdi lai viin ban
nhuw truwée do:

a) Dung Iénh Edit, Undo

b) Dong tap tin d6 nhung khong luu

¢) Caavab déu ding

d) Caavab déu sai
73. Dé dinh dang lai cho Ky tu trong WinWord, ta
dung:

a) Format, Paragraph

b) Format, Style

c) Format, AutoFormat

d) Format, Font
74. Dé tang khoang cach doan chira con tré véi
doan van dwéi no, ta dung menu:

a) Format, Spacing Before

b) Format, Spacing After

c) Format, Paragraph, Spacing Before

d) Format, Paragraph, Spacing After
75. Dé ghép dir liéu nhiéu 6 trong bang thanh mét
o, ta danh du cac 6 dé va dung menu:

a) Table, Merge Cells

b) Table, Sum Cells

c) Table, Split Cells

d) Table, Split Table
76. Cach nao dwéi diy duoc sir dung dé di chuyén
mot doan vian ban sau khi da chon né?

a) Chon File = Copy va chon Edit - Paste

b) Chon Edit - Copy va chon File - Paste

c) Chon File & Copy, chuyén con tré dén vi tri
méi va chon Edit 2> Paste ’
d) Chon Edit = Cut, chuyén con tré den vi tri

méi va chon nut Paste ﬁ trén thanh céng cu
77. Dé thu nhé chir nim dwéi (Chon Format >
Font va chon Subscript), ta thuc hién:

a) Nhan t6 hop phim Ctrl + =

b) Nhan t hop phim Shift + =

¢) Nhén t6 hop phim Ctrl + Shift + =

d) Caub vac diang

78. Viéc nao dwéi day khong thuc hién dwgc khi ta
danh sb trang bang 1énh Insert > Page
Numbers...?

a) Dit sb the tu trang ¢ du trang hay phia dudi
cua trang

b) it s the tu ¢ gitra hoic bén mép trai hay
mép phai cua trang

¢) Dit sb tha tu trang & c4c vi tri khac nhau ddi
véi trang chan va trang lé

d) Paénh sb trang bang chir (mét, hai, ba, ...)

79. Cau nao sau day la sai:

a) Lénh Format - Borders and Shading... dung
dé tao dudng vién va td mau nén cho doan vin
ban

b) Lénh Format - Borders and Shading... dung
dé dinh dang bang

c) Lénh Format - Borders and Shading... dung
dé tao dudng vién va td mau nén cho bang

d) Lénh Format - Borders and Shading... dung
dé tao dudng vién va td mau nén cho ky tu

80. Pé thay doi dinh dang ky tu cho mdt cum tir,
trudc tién ta phai thyc hién thao tiac nao?

a) Dung phim tat Ctrl + |

b) Chon toan bo cum tir d6

¢) Chon tir cudi cing

d) Dua con trdé van ban téi cum tir do

81. Pé thém dong, ¢t vao bing, ta chon:

a) Table - Insert c) Table >
Formula
b) Table - Delete d) Table > Merge
Cells
82. Dé thay doi vi tri 18 ciia cac doan viin ban, ta

phai:
a) Chon Format > Paragraph va thay d6i cac
thiét dat & muc Indentation
b) Chon Format - Tabs
¢) Chon Format - Spacing va thay doi cé4c thiét
dat & muc Indentation
d) Chon nat Paragraph Spacing trén thanh cong
Cu
83. Cach nao trong cac cach sau cho phép st dung
ban phim dé mé bang chon?
a) Nhan git phim Ctrl rdi gd ki tu dugc gach
chén trong tén bang chon



b) Nhan gitr phim Alt rdi gé ki tu dugc gach
chan trong tén bang chon
¢) Nhan gitr phim Shift réi go ki tu dwoc gach
chan trong tén bang chon
d) Khoéng cd cach nao ca
84. Dé dong tép van ban dang soan thao, ta chon
thao tac nao sau day:
a) File > Exit c) File = Quit
b) File - Close d)Ctrl +S
85. Dé giam c& chit, ta thuc hién:
a) Nhan t6 hop phim Ctrl + ]
b) Nhan t6 hop phim Ctrl + Shift + >
c) Nhan t6 hop phim Ctrl + [
d) Céauavab diang
86. Nhan Ctrl + Home dong thoi sé thuc hién viéc
nao?
a) Dat con tré van ban dén dau tir hién tai
b) it con tré van ban dén dau doan hién tai
¢) Dit con tré vin ban dén dau dong hién tai
d) Dit con tré vin ban dén dau vin ban
87. Trong cac cach dudi day, cach nao nén dung
dé cin chinh ndi dung trong mot 6 xudng sat day?
a) Dung céc khoang tréng trude noi dung
b) Nhan nhiéu lan phim Enter
c) Chon nat Iénh Cell Alignment =k trén thanh
cong cu
d) Cauavab dung
88. Pé g duwoc chir cai in hoa, ta
a) Giir Shift roi gd phim twong ung
b) Giir Ctrl rdi gd phim tuwong ing
¢) Giir Tab roi gd phim twong ting
d) Giir Alt roi gd phim tuong @ng
89. Pé két thic phién lam viéc véi Word, ta
a) File > Exit c) File > Close
b) File - Quit d) Ctrl +S
90. Nhan Shift + End df“)ng thoi s€ thyc hién viéc
nao?
a) Chon tir con tré vin ban dén cudi dong
b) Chon tir con tré vin ban dén cubi van ban
c) Chon tir con tré vin ban dén hét doan
d) Chon dén dong tiép theo
91. Trong WinWord, nhin t6 hgp phim Ctrl + D
dé mé hop thoai:
a) Font c) Page Setup
b) Paragraph d) Khong ¢6 cau nao ding
92. Pé dong t&p vin ban dang soan thio, ta chon
thao tac nao sau day:

Chon vin ban bing ban phim:

a) Alt+F4 c) Ctrl+ W

b) File - Exit d) Cau a va b ding
93. Nhén Shift + Home dong thoi sé thye hién viée
nao?

a) Chon tir con tré van ban dén dau dong

b) Chon tir con tré vin ban dén dau vin ban

c) Chon tir con tro van ban dén dau doan

d) Chon dén dong ngay trén
94, Pé ting c& chir, ta thwe hién:

a) Nhan t6 hop phim Ctrl + ]

b) Nhan té hop phim Ctrl + Shift + <

¢) Nhan t6 hop phim Ctrl + [

d) Cauavab diang
95. Pé thu nhé chir nim trén (Chon Format >
Font va chon Superscript), ta thwe hién:

a) Nhan t hop phim Ctrl + =

b) Nhan té hop phim Ctrl + Shift + =

¢) Nhan t hop phim Shift + =

d) Céauavab ding

96. Nut Iénh Cell Alignment =k trén thanh cong
cu Tables and Borders dung dé:

a) Can 1& vin ban trong 6

b) Dinh dang duong vién cho bang

¢) Téach mot 6 thanh nhiéu 6

d) Gop nhiéu 6 thanh mot &
97. Nt 1énh nio sau day gop nhiéu 6 thanh mot 6?

a) &InsertTable c)EMerge Cells

b) K& split Cells d) B outside
Border
98. Pé thay thé tir hay cum tir, ta nhin to hop
phim:
a) Ctrl+F c)Ctrl+E
b) Ctrl +L d) Ctrl +H

99, Pé chén tiéu dé diu trang (header) va tiéu dé
chan trang (footer), ta thuc hién:

a) View, Header and Footer

b) Insert, Header and Footer

c) Edit, Header and Footer

d) Format, Header and Footer
100. D¢ thue hién ngit trang, ta dit con tré vao vi
tri cAn ngit va chon:

a) Insert, Page break, Break...

b) Insert, Break..., Page break

c) Format, Page break, Break...

d) Format, Break..., Page break

Ctri+ A Chon toan bo van ban
ih)'ft +> (ShIft + | opon mot ky tu bén phai (bén trai)

Ctrl + Shift + >
(Ctrl + Shift + &)

Chon tir vi tri con tro dén cubi tir (dau tir)




Shift + Home
(Shift + End)

Chon tir vi tri con tro dén dau dong (cudi dong)

Ctrl + Shift + \V
(Ctrl + Shift + )

Chon tir vi tri con tro dén cudi doan vin (dau doan
van)

Shift + ¥
(Shift + N

Chon dén dong tiép theo (ngay trén)

Ctrl + Shift + Home
(Ctrl + Shift + End)

Chon tir vi tri con tro dén dau van ban (cubi vin ban)

Di chuyén con tré vin ban bang ban phim:

>, € ¥, A 3?”9 trai mot ky tw, sang phai mot ky tu, xuong mot dong, 1én mot
ong

Home NN o

(End) V¢ dau dong (cuoi dong)

PageUp An (11 k 5 .

(PageDown) Lén (xuong) mot trang man hinh

Ctrl + Home C e o

(Ctrl + End) V¢ dau van ban (cuoi van ban)

Ctrl + PageUp o o ’

(Ctrl + V¢ dau trang trugc (Vé dau trang tiép theo)

PageDown)




EXCEL

1. Trong Excel ta chon Menu/ Insert/ Worksheet | 11. Trong Excel dé ndi dir liéu ciia 2 6 C1 va C2,
1a dé: ta chon 6 va dung cong thirc:
a. Tao mot do thi. a. =C1&C2
b. Thém mot Sheet vao bang tinh do. b. =C1$C2
c. Thém mdt hang vao bang tinh. c. =C1+C2
d. Ca3 cau déu sai. d. Ca3 cau déu sai.
2. Trong Excel ta chon Menu/ Insert/ Cells 1a dé: 12. Trong Excel dé danh s thit tw trong bang tinh
a. Thém mot 6 vao bang tinh do6. ta chon:
b. Thém mot cit vao bang tinh do. a. View/ Fill/ Series.
c. Thém mot hang vao bang tinh. b. View/ Series.
d. Ca 3 cau déu sai. c. Insert/ Series.
3. Trong Excel ta chon Insert/ Column la dé: d. Edit/ Fill/ Series.
a. Thém mot cdt vao bén phai cdt hién hanh. 13. Trong Excel dé thém mot hang vao bang tinh
b. Thém mot cot vao bén trai cot hién hanh. ta chon:
c. Xoa cot hién hanh. a. Edit/ Insert/ Row.
d. Ca3 ciu déu sai. b. Insert/ Row.
4. Trong Excel dé tao mét tap tin méi ta chon: c. Insert/ Columns.
a. File/ New. d. Table/ Insert/ Columns.
b. Tb hop phim Alt + F + N. 14. Trong Excel dé tinh gia tri trung binh ciia
c. Caavab déu sai. ving dir li¢u s6 tir 6 C1 dén C5, ta ding
d. Caavab déu ding. cong thirc:
5. Trong Excel ta dung phim F2 1a dé: a. =Sum(C1:C5)/5
a. Chinh stra dir liéu mét 0. b. = Average(C1:C5)
b. Tim kiém va thay thé. c. =(C1+C2+C3+C4+C5)/5
¢. Tim kiém nhung khong thay thé. d. Ca3 cau déu dung.
d. Ca3 cau déu sai. 15. Trong Excel tir 6 Al dén A5 1a dir liéu s6 déu
6. Trong Excel ta dung phim Ctrl + H 1a dé: bang 2, A6 va A7 déu la dir liéu chudi, ham
a. Cai thudc tinh 4n cho bang tinh. Count(A1:A7) cho két qua la:
b. Bao mat bang tinh. a. 20
c. Tim va thay thé dir liéu. b. 7
d. Ca3 cau déu sai. c. 5
7. Trong Excel dé xép hang ta dung ham: d. # Value.
a. Sort. 16. Trong Excel ham Date(T1, T2, T3), T1, T2 va
b. Rank. T3 twong wng:
c. Rand. a. Ngay, thang, nam.
d. Round. b. Thang, Ngay, nam.
8. Trong Excel dé sip xép dir li¢u ta chon: c. Néam, Thang, Ngay.
a. Tools/ Sort. d. Tuy theo dang Date dugc cai dat trong
b. Format/ Sort. Regional Settings.
c. Table/ Sort. 17. Trong Excel ta c6 thé m& dwoc nhiéu tap tin,
d. Data/ Sort. nhung dé 1am viéc véi mot tap tin ta vao:
9. Trong Excel dé rit trich dir li¢u ta chon: a. Window, chon tap tin.
a. Data/ Filter. b. Tools, chon tap tin.
b. Tools/ Sort. c. Help, chon tap tin.
c. Data/ Group. d. Edit, chon tap tin.
d. Data/ Sort. 18. Pé chon nhiéu cdt khong lién tiép trong bang
10. Trong Excel dé sao chép dir li¢u tir vi tri nay tinh Excel, ta thyc hi¢n:
dén vi tri khac ta chon: a. Nhan va giit phim Alt + Click chon ting cot.
a. Edit/ Copy, Edit/ Paste. b. Nhan va giit phim Shift + Click chon timg cot.
b. Edit/ Copy, Edit/ Paste Special. ¢. Nhan va gilt phim Ctrl + Click chon tirng c6t.
c. Ctrl+C,Ctrl +V. d. Khéng thé chon duoc.
d. Ca3 cau déu dung. 19. Pé chon nhiéu cot lién tiép trong bang tinh
Excel, ta thwe hién:
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20.

21.

22,

23.

24,

25.

26.

27,

Nhéan va giit phim Alt + Click chon cot ddu va

ot cudi.

Nhéan va giit phim Shift + Click chon cot dau

va ¢t cudi.

Nhéan va giit phim Ctrl + Click chon cot dau

va cot cudi.

d. Khong thé chon duoc.

Trong Excel, mt WorkBook cé toi da bao
nhiéu Sheet (WorkSheet)?

a. 3.

b. 16.

c. 255.

d. Khong xac dinh, tiy nguoi st dung chon.

Trong Excel, dé tinh trung binh ciia viung dir

liéu s6 tir C1 dén C5 ta ding cong thirc:

=Averag(C1:C5).

=Averge(C1:C5).

=Average(C1:C5).

=Averrage(C1:C5).

Trong Excel, dé tim va thay thé mét dir liéu ta
vVao:

a. File/ Replace.

b. Edit/ Replace.

c. View/ Replace.

d. Tools/ Replace.

Trong Excel, Menu nao sau day khong co:

a. Insert.

b. Format.

c. Tools.

d. Table.

Trong Excel, gia sir 6 B3 chira 3010, vay dir

liéu 0 B3 la:

Dit ligu so.

Dir liéu chudi.

Dt liéu ngay (Date value).

Ba cau trén déu c6 thé ding.

Trong Excel, dé sao chép gia tri ciia 6 A3 vao &

A9 thi tai 0 A9 ta dung cong thurc:

C.

op o

cp o

a. =A3.
b. =$A3.
c. =$AS%3.

d. Ca3 cau déu dung.

Trong Excel, ta c6 thé xoa ca mdt Sheet biang
cach:

a. Edit/ Delete Sheet.

b. Edit/ Delete.

c. Edit/ Move.

d. Khong xoa dugc ca Sheet.

Trong Excel, hAm nao sau diy cho ta s6 1am
tron dén 0.5 cia dir liéu so trong 6 C5:
Round(C5*2,0)/2.

Round(C5*2,1)/2.
Round(C5*2,-1)/2.
Round(C5*2,2)/2.

oo oo
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28. Trong Excel, ham nao sau day cho ta phin
nguyén cia dir liéu s6 trong 6 C5:

a. Int(C5).

b. Mod(C5).

c. (C5/2)*2.

d. Ca3 cau déu sai.

Trong Excel, dé sira tén mot Sheet ta thuc

hién:
a. Edit/ Sheet/ Rename.
b. View/ Sheet/ Rename.
c. Format/ Sheet/ Rename.
d. Tools/ Sheet/ Rename.
30. Trong Excel, dé chon phong chir mic nhién
cho mot bang tinh, ta thyc hién:
a. Format/ Cell/ Font/ Default.
b. Font/ Character/ Spacing/ Default.
c. Font/ Font/ Cancel.
d. Tools/ Option/ General/ Font.
Pé chinh sira dir liéu mot 6 ta dung phim chic
nang:
a. FL.
b. F2.
c. Fa.
d. F6.
Trong Excel, 6 xuit hién chir #VALUE! bao
16i:
a. Nhap sai cong thuc.
b. Trong cong thirc c6 tén 6 hién hanh.
c. C6 1an 6 dang chudi trong phép tinh.
d. Do rong cua 6 chira dir liéu qua nho.
O A1 chira gia tri chudi ‘NGUYEN CONG
TRU’, HAM Right(A1,8) cho gia tri 1a:

a. NGUYEN.

b. NGUYEN CO.

c. CONG TRU.

d. NGUYEN C.

34. Pé tré thanh dia chi tuyét doi, ta chon dia chi
d6 va nhéan phim:

a. F4.

b. Fb5.

c. F6.

d. F7.

O Al chira gia tri chudi ‘NGUYEN CONG
TRU’, HAM Left(Mid(A1,8,8),4) cho gia tri
la:

a. UYEN.

b. CONG.

c. ENCO.

d. TRU.

Cau nao sau day sai:

a. Bang tinh c6 256 cot va 65536 dong.

b. Tén tap tin c6 thé dai hon 8 ky tu.

. Chudi dai hon d6 rong ctia 6 ludn ludn bi che
khuét.

d. Trong mot 6 c6 thé chira nhidu hon 256 ky tu.

29.

31.

32.

33.

35.

36.



37

38

39

40

41.

42.

43.

44,

45.

46.

. O Al chira dit ligu s6 5, 6 A2 chira chudi
“HOC?”, cau nao sau day bao loi:

a. =Al+A2,

b. =Sum(Al:A2).

c. =Average(Al:A2).
d =Al&A2.

. P& tinh trung cdng cac 6 dir liéu sb tir A1 dén
A4 va ghi két qua vao 6 AS. Tai 6 A5 ta go:
=Average(Al:A4).

=Sum(Al:A4)/4.

= (A1+A2+A3+A4)/4.

Ca 3 cau déu dang.

tinh trung cong cac 6 dir li¢u s6 tir A1 dén
A4 va 1am tron dén 0.5, ghi két qua vao 6
AS. Tai 0 AS ta go6:
=Round(Average(Al:A4)*2,0)/2.
=Round(2*Sum(A1:A4)/4,0)/2.
=Round(2*(A1+A2+A3+A4)/4,0)/2.

Ca 3 cau déu ding.

. O A1 c6 gia tri s6 6.66 va 6 A2 c6 gia tri sb
3.33. Cong thirc =Round(A1,1) — Int(A2)
cho két qua:

3.7.

3.0.

3.3.

. 6.0.

Trong Excel, ham Concatenate ding dé:

a) Chuyén dbi chudi s6 thanh kiéu sb

b) N&i chudi

¢) Bém chiéu dai chudi

d) Cat bo khoang trang du trong chudi

Cong thirc =ROUND(3578.568, -2) cho két qua

opow

. be

a.
b.
C.
d.

cp oo

la:
a) 3578.56 c. 3500
b) 3578.57 d. 3600

Chon cau sai:

a) Ham la cong thic duoc xay dung san

b) Ta chi nhap dugc ham tryc tiép tir ban phim
vao trang tinh

¢) Cong thuc cia Excel thuong bt dau bang dau
= hoic dau +

d) Dung phim F2 dé c6 thé diéu chinh dit ligu tai
0 dang chon

Tai 6 C1 chira s6 123, tai 6 C2 chira s6 456, tai
6 C3 chira s6 789. Cong thirc =C1&C2&C3
cho két qua:

a) 1368 c) Mot két qua khéc

b) 123456789  d) Béo I3i

O A2 c6 gan chudi “1213A4” (khdng cé cap

déu “”), tim két qua cia 6 E2 néu 6 nay chira

cong thirc =VALUE(RIGHT(A2,1)):

a) 4 c) 1213

b) 12134 d) 1213A4
Cong thixc =MOD(10/3) sé cho két qua la:

a) 1

12

47.

48.

49.

50.

o1.

52.

53.

b) 2
c) 3
d) Ca ba cau trén déu sai
Trong Excel, dé ké khung cho 1 khaéi 9, ta
dung Iénh nao sau day:
a) Format, Row c. Format, Cells
b) Format, Sheet d. Format, Column
Gia sir 6 D4 c6 chudi “Hai tram 2 muoi”.
Ham =LOWER(D4) cho ra:
a) hai tram 2 muoi
b) HAI TRAM 2 MUOI
¢) Hai Tram 2 Muoi
d) 220
Giasw 6 A3cogiatri8, 6 B3cogiatrila
10, 6 C3 cO ky tw T, 6 D4 nhap ham
=Average(A3,B3,C3) cho gia tri:

a) 6 c) 0
b) 9 d) May béo 15i
Trong Excel, dé sao chép 1 sheet ta vao:
a) Edit, chon Delete Sheet
b) File, chon Copy Sheet
c) Edit, chon Move or Copy Sheet
d) Ba cau trén déu sai
Pé dat tén cho mat vang bang tinh Excel ta

dung Iénh:
a) Insert, Name, Define...
b) Data, Name, Define...
c) Edit, Name, Define...
d) Tools, Name, Define...
Trong Excel, tim va thay thé 1 chudi ta
ding to6 hep phim
a) Ctrl-P c)Alt-F
b) Ctrl-A d) Ctrl - H
O C1 chira dir liéu dang chudi A115. Nhap

cbng thiec =VALUE(RIGHT(C1,3))>0 vao 6 C2.
Dir li¢u trong 0 sé la:

54,

55.

a) 115 c) TRUE
b) 0 d) FALSE
O Al chira gia tri sé 1a 7, 6 B1 chira gia tri
chudi 1a “ABC”. Ham =AND(A1>5,
B1="ABC”) sé cho ra két qua la:
a) TRUE c) 1
b) FALSE d) 2
Khai bao List Range trong hop thoai
Advanced Filter diung dé:
a) Khai bao ving co so dir liéu goc, tir do dit liéu
duoc trich ra
b) Khai bao vung diéu kién da thiét lap dé can ctr
rut trich
Khai bao viing két xut noi chira cac mau tin
trich duoc
Khoéng phat biéu nao dung, ving ndy co thé
khai bao hozc khong

c)
d)



56. O B5 chira chudi “A0018”, 6 C5 chira gia
tri s6 156.389, 6 D5 xuit hién chir FALSE. Cho
biét cong thirc c6 thé c6 ciaa & D5
a) =OR(VALUE(RIGHT(B3,2))>20,

INT(C3/100)>1)

b) =AND(LEFT(B3,1)="A”, 63.

ROUND(C3,1)>118.4)
c) Ca2 A vaB déu khong thé
d) Ca2 A vaB déucdthé
57.  Trong Excel hdy cho biét két qua caa cong
thire sau: = MID(“X3Y2Z1”, 4, 2)

a) Y2 c) 3Y2 64.

b) 271 d) 2Z

58.  Trong Excel, ta chon Insert/Rows la dé:
a) Thém mot dong vao bén trén dong hién hanh
b) Thém méot dong vao bén dudi dong hién hanh
c) Xba dong hién hanh

d) Ca 3 cau déu sai 65.

59. O A6 chira chudi “8637736X”. Ham
=VALUE(A6) cho két qua:
a) 8637736 ¢) Khoéng xuat hién gi ca
b) 0 d) May béo 15i

60.  Trong Excel, dé xa mt hang va don dir

liéu hang dwéi Ién, ta chon hang can xda va 66.

dung lénh sau:
a) Edit, Clear..., All
b) Edit, Delete..., Shift Cell Up
c) Edit, Delete..., Entire Row
d) Ba cau trén déu ding
61.  Ham SUMIF(vung 1, diéu kién, viing 2) la

ham ding dé: 67.

a) Tinh tong cac 6 kiéu s trong viing 2 thoa diéu
kién trong vung 1

b) Tinh tong céc 6 kiéu s6 trong ving 1 thoa diéu
kién trong vung 2

a) Dai chudi text thanh mot gia tri sb
b) Dbi chudi text c6 dang ky s6 thanh mét gié tri
s6 tuong g
¢) Caavab déu sai
d) Caavab déudung
Ham COUNTA(vung 1,vung 2, ...) la ham
dung dé:
a) Dém cac 6 khéc rdng trong cac dija chi ving
b) Dém cac 6 kiéu sd trong cac dia chi ving
¢) Caavab déu ding
d) Caavab déu sai
Trong Excel, dé sira ttn mdt Sheet ta thuc
hién:
a) Click phai vao tén Sheet va chon Rename
b) Double click vao tén Sheet
c) Chon Format/Sheet/Rename
d) Caa,b,cdéu diang
_ Trong Excel, ta chgn menu Insert/Cells la
de:
a) Thém mot 6 vao bang tinh do
b) Thém mot cot vao bang tinh d6
c) Thém mot hang vao bang tinh d6
d) Ca 3 cau trén déu sai
Trong Excel, ta dung phim F4 la dé:
a) Chuyén mot dia chi twong dbi thanh dia chi
tuyét doi
b) Chuyén mot dia chi tuyét d6i thanh dia chi
tuong ddi
¢) Chinh stra dir liéu mot 6
d) Cauavab dung
$E$2 Ia toa @9 tham chiéu:
a) Tuong ddi theo hang 2, tuong ddi theo cot E
b) Tuong d6i theo hang 2, tuyét d6i theo cot E
¢) Tuyét d6i theo hang 2, tuyét d6i theo cot E
d) Khong cau nao dung

¢) Caavab déusai 68. Cong thirc =(1<3)-(2=7) c6 két qua Ia:
d) Caavab déudung a) 1 ¢) TRUE
62.  Ham VALUE(text) la ham dung dé: b) 0 d) FALSE
Cho bang dir liéu sau:
A B C D E F
1| M&HS Ho Tén Ngay sinh Toén Van
2 | TNA003 | Tran Thanh Sang 11/12/1992 | 6 9
3 | HPB008 | Pham Thi Ha 19/09/1992 |5 4
4 | NKB098 | Tran Lé Hoa 05/10/1992 |8 9
5 | NKA015 | Ha Lan Anh 24/10/1992 | 9 8
6 | TNA037 | Vii Thay Binh 09/12/1991 |6 5
69. Pé lay ky tw thir 3 cia M& HS (6 A2) ta dung 71. Pé tinh diém trung binh véi TOAN hé s 2,
cong thirc: VAN hé s6 1 ta ding cong thic:
a) MID(A2,3,1) ¢) MID(A2,1,3) a) =AVERAGE(E2:F2)
b) MID(A2,2,1) d) MID(A2,1,2) b) =(E2*2+F2)/3
70. Cong thirc =COUNT (A2:A6) cho két qua: c) =E2*2+F2/3
a) 5 ¢) #VALUE! d) Caua,b, ¢c déu dung
b) 0 d) Khéng hién gi ca
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72. Cong thire =VLOOKUP(“Ha”,C2:F6,3,0)

b) =YEAR(TODAY()) - YEAR(D2)

cho két qua: ¢) =YEAR(TODAY()) - D2
a) 3 c) 5 d) Tatca déu sai
b) 4 d) Két qua khac 75. Cong thirc =B3&E3 cho két qua:
73. Cong thirc =VALUE(RIGHT(A5,3)) cho két a) “Tran Thanh Sang”  c) #N/A
qua: b) “Pham Thi Ha” d) Caa,b,cdéu
a) “015” c) #VALUE! sai
b) 15 d) Két qua khéc 76. Ham =AND(E3>=5,F3>=5) cho két qua:
74. Pé biét dwoc tudi caa hoc sinh, ta dung cong a) 1 ¢) TRUE
thirc: b) 0 d) FALSE
a) =TODAY()-D2
DAP AN LY THUYET
HE PIEU HANH WINDOWS
1 C 6 B |11 | D |16] Cc |21 A|2 | A |3 ]| A |3 ]| B
2 D 7 D |12 | B |17 | D |22 | B |27 | D[3 ]| B |37 ]| C
3 | A | 8 B | 13| B |18 | A | 23| D | 28| B |3 | D |3 | D
4 B 9 B |14 | D |19 | C | 24| C | 29| D |3 | C |3 | B
5 B |10 | B | 15| D | 20| B | 25| D |3 | B |3 | D4 | D
MICROSOFT WORD
1 D 6 D |11 | D |16 | D |21 | C |2 | D |3 ]| cCc]|3]|C
2 A 7 D |12 | A |17 | A | 2| A | 27| B |32 | A |3 | B
3 C 8 D |13 | B |18 | C | 23| B | 28] A [3 | B [38]|D
4 B 9 | AJ14| Cc | 19| D|24a| B | 29| A |3 ]| C|3]|CcC
5 B |1 | c |15 | B |20 | D|25 | Cc |3 | C |3 ]| D]J|4]|D
41 | B |46 | B | 51| D |5 | A|61 ]| DJ|666]|] A|]71] D]|76] D
42 | c | 47| B |52 | B |57 | D |6 | D |67 cCc|72]|]cCc]|77]|A
43 | A | 48 | D | 53| D |58 | B | 63| C |68 A | 73| D | 78] D
44 | D | 49| A |54 | B |59 | A | 64| A| 69| A|74| D]|]79] B
45 | A |50 | D|5 | A|[60| D|65| A|]70| A | 75| A | 8 | B
81 | A [8 | D|]91| A | 9% | A
82 | A |8 | C |92 | D |97 C
83| B |8 | A | 93| A |9 | D
84 | B [ 8 | A |9 | A]|] 9| A
85 | ¢ | 90| A |95 | B |100]| B
MICROSOFT EXCEL
1 B 6 c | mm|]A]J1w|]c|]22]c|]26] A[3]| B |36]|C
2 A 7 B |12 | D |17 | A |2 | B |27 | A |32 | C |37 ]| A
3 B 8 D |13 | B |18 | C | 23| D[ 28] A [3 ]| cCc |[38]|D
4 D 9 A |14 | D |19 | B |24 | D |29 | C |3 | A |3 | A
5 | AJ1w | DJ|]15|] c|]20]| D|25| D |3 | D |3 | B | 4] A
41 | B | 46 | D | 51| A | 56| A | 61| A |66 | D | 71| B |7 | D
42 | D |47 | c |52 | D|57 | D |6 | B |6 | cCc|7]|]c|77]8B
43 | B | 48| A | 53| C | 58| A | 63| C | 68| A |73 B |78]|D
44 | B | 49| B | 54| A |5 | D |64 | D|69 | A | 74| B
45 | A |50 | Cc | 55| A |60 | Bo | 65| A | 70| B | 75| D
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